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Using the documentation

Thank you for buying a Brother machine! Reading the documentation will help you make the most of your 
machine.

Symbols and conventions used in the documentation

The following symbols and conventions are used throughout the documentation.

IMPORTANT IMPORTANT indicates a potentially hazardous situation which, if not avoided, may 
result in damage to property or loss of product functionality.

NOTE Notes tell you how you should respond to a situation that may arise or give tips 
about how the operation works with other features.

Bold Bold style identifies keys on the machine control panel or computer screen.

Italics Italicized style emphasizes an important point or refers you to a related topic.

Courier New Courier New font identifies the messages shown on the LCD of the machine.

NOTE
• For DSmobile 920DW users: this guide uses DSmobile 820W screen images, unless otherwise indicated.

• If you are using a tablet running Windows®, you can make your selections either by tapping the screen or 
by clicking with your mouse.
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Trademarks

Brother and DSmobile are registered trademarks of Brother Industries, Ltd.

Apple, Macintosh, Mac OS and App Store are trademarks of Apple Inc., registered in the United States and 
other countries.

Windows and Windows Vista are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and / or other countries.

Wi-Fi is a registered trademark of the Wi-Fi Alliance.

Google Play and Android are trademarks of Google Inc.

Nuance, the Nuance logo and PaperPort are trademarks or registered trademarks of Nuance 
Communications, Inc. or its affiliates in the United States and / or other countries.

Any trade names and product names of companies appearing on Brother products, related 
documents and any other materials are all trademarks or registered trademarks of those respective 
companies.
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Basic functions

Storing scanned images

*1: This function is not available while using the Wi-Fi® connection.

Scan to your computer *1 Scan to an SD Memory Card (SD card)

You can store scanned images on your computer when 
the Micro USB Cable is connected to the scanner and the 
computer. For more information, see Scan Using Your 
Computer on page 19.

You can store scanned images on the SD card included 
with your scanner. For more information, see Scan Using 
the Control Panel on page 18.
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Accessing scanned images stored on the SD card

View in the browser
View on your computer or mobile 
device via an access point

View on your computer via 
the USB connection

Access scanned images stored on the 
SD card via the web browser of a 
wireless LAN tablet or your computer. 
For more information, see Using your 
web browser on page 49.

Access and view scanned images 
stored on the SD card from your 
computer or mobile device.
For more information, see Wi-Fi® 
Connection on page 47.
For more information, see Using 
Avision (miwand) (Android™) or 
Using Avision (miwand) (iOS) on 
page 53.

Access and view scanned images 
stored on the SD card from your 
computer when it is connected to your 
scanner via the supplied Micro USB 
Cable. For more information, see Using 
the USB connection between your 
scanner and computer on page 52.
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Scanner overview

Front

1 Top cover

2 Control panel

3 Reset button

4 Battery compartment

5 Wi-Fi® (ON / OFF) switch

NOTE
When you are not using the Wi-Fi® function, set the Wi-Fi® switch to OFF. If you leave the switch in the ON 
position, the battery will discharge faster.

6 Document guide

7 Feeder slot

8 Left edge

9 SD card slot
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Rear

1 Micro USB port

2 SD card slot

3 Paper ejection slot
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Control panel overview

1 Wi-Fi® indicator

Indicates the status of the Wi-Fi® connection.

2 Menu button

Press to configure the menu settings.

3 Power button

• Press to turn on the scanner.

• Press and hold to turn off the scanner.

4 Start / OK button

• Press to confirm a selected item.

• Press to switch from SD mode to PC/TWAIN mode. (You can select SD mode only when an SD card 
is inserted in the scanner’s SD card slot. You can select PC/TWAIN mode only when the scanner is 
connected to your computer via the Micro USB Cable.)

• For Windows®

Press to start scanning when using Button Manager V2. (Only available when a document is set in the 
feeder slot.)
For more information, see Using Button Manager V2 (for Windows®) on page 41.
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• For Macintosh

Press to start scanning when using DSmobileCapture. (Only available when a document is set in the 
feeder slot.)
For more information, see Using DSmobileCapture (for Macintosh) on page 35.

5 PDF / JPG ( ) button

• Press to change the scanning file format (PDF or JPEG).

• Press to scroll through the menu and option items.

6 HQ / STD ( ) button

• Press to change the resolution. HQ is 600 dpi and STD is 300 dpi.

• Press to scroll through the menu and option items.

7 COLOR / MONO ( ) button

• Press to change the scan mode (color or mono [black and white]).

• Press to return to the previous screen.

8 Liquid Crystal Display (LCD)

Displays messages to help you set up and use your scanner.

9 2 side / 1 side ( ) button (DS-920DW only)

• Press to change the scan mode (2 side scan or 1 side scan).

• Press to scroll through the menu and option items.
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Items displayed on the LCD

1 SD

Appears when the SD card is inserted into the scanner’s SD card slot.

2 Remaining battery power

3 The selected menu or the current status appears here

For more information about the messages displayed on the LCD, see LCD messages on page 6.

4 PDF / JPG

Displays the scanning file format (PDF or JPEG).

5 HQ / STD (DS-820W only)

Press to change the resolution. HQ is 600 dpi and STD is 300 dpi.

6 COLOR / MONO

Displays the scan mode (color or mono [black and white]).

7 2 / 1 (DS-920DW only)

Displays the scan mode (2 side (double-sided) scan or 1 side (single-side) scan).
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LCD messages

Power button LED indications

Message Scanner Status

The scanner is connected to your computer in TWAIN mode.

The scanner is in SD mode (Mass-storage mode). 

For more information, see Scanning in SD mode on page 18.

(DS-920DW only) The scanner displays the menu to change the resolution. 

For more information, see Changing the scan resolution (DS-920DW only) on page 11.

The scanner displays the menu to format an SD card.

For more information, see Formatting an SD card on page 11.

The scanner displays the menu to set its clock.

For more information, see Setting the Clock on page 8.

The scanner displays the calibration menu.

For more information, see Calibration using the control panel on page 61.

The scanner displays the menu to use the auto power off function.

For more information, see Using the auto power off function on page 8.

The scanner is not connected to your computer and there is no SD card inserted.

LED indication Scanner Status

No light The scanner is not connected to your computer or the Li-ion battery is not installed.

Green The scanner is ready to scan or is charging the battery.

Blinking green The scanner is scanning a document.

Rapidly blinking red An error has occurred. The top cover is open, or a document is jammed.
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Checking the Wi-Fi® indicator

NOTE
When you are not using the Wi-Fi® function, set the Wi-Fi® switch to OFF. If you leave the switch in the 
ON position, the battery will discharge faster.

Wi-Fi® indicator Wi-Fi® status

No light The Wi-Fi® switch is set to OFF.

Lit (Red) The Wi-Fi® switch is set to ON and the scanner is starting up a Wi-Fi® connection. It takes 
about 40 seconds to make the Wi-Fi® connection.

Lit (Blue) A Wi-Fi® connection has been made in access point (AP) mode.

For more information, see Connecting in access point (AP) mode on page 47.

Lit (Orange) A Wi-Fi® connection has been made.

For more information, see Connecting in access point (AP) mode on page 47 or 
Connecting in infrastructure mode on page 48.

WiFi

WiFi

WiFi

WiFi
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Setting the Clock

Before using your scanner, set the scanner clock to the correct time.

a Turn on your scanner.

b On the scanner’s control panel, press Menu.

c Press  or  until TME is displayed on the LCD.

d Press Start / OK.

e Press  or  to set year.

f Press Start / OK to confirm the year.

NOTE
To return to the previous screen, press the COLOR / MONO ( ) button.

g Repeat steps 5 and 6 to set the month, day, hour (24-hour format) and minutes.

h After setting the minute, the LCD displays OK, indicating that the clock is set.

Using the auto power off function

You can turn your scanner off automatically to save power. The scanner will power off after five minutes of 
inactivity.

NOTE
When the Wi-Fi® switch is set to ON, this function is disabled.

a Turn on your scanner.

b On the scanner’s control panel, press Menu.

c Press  or  until PWR is displayed on the LCD.

d Press Start / OK.

e Do one of the following:
• To enable the auto power off function, press  or  to select YES.
• To disable the auto power off function, press  or  to select NO.

f Press Start / OK.

g The LCD displays OK, indicating that auto power off has been set.
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Installing the battery

Install the supplied Li-ion Battery into the side of your scanner, as shown in the illustration.

DS-820W DS-920DW
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Charging battery

a Make sure that your computer is ON.

b Connect the supplied Micro USB Cable to the micro USB port  on your scanner. 

c Connect the cable to your computer. The battery starts charging automatically.

d The Power button  lights up green while the battery is charging, and goes off when charging is complete.

NOTE

• When charging the battery, press and hold the Power button  to turn off your scanner. You can charge 

the battery with the power either on or off, but charging takes more time when the scanner is on.

• When charging the battery with the power on, set the Wi-Fi® switch  to OFF.

• When the scanner is turned on, the battery level is displayed on the LCD panel. 

• If you do not use the scanner for a long period, charge the battery fully at least once every six months to 
prolong the battery life.

• If you do not use the scanner for a long period, remove the battery from the scanner, and store the battery 
in a cool, dry place at a consistent temperature.

Battery icon Power level

Full

Half full

Low
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Formatting an SD card

If you want to use your own SD card (not supplied with the machine), you must format the SD card first.

NOTE
Before formatting an SD card, make sure if there is no important data on it. When you format an SD card 
that was previously used with other devices, all of its data will be deleted.

a Insert the SD card into the SD card slot.

b Turn on your scanner.

c Make sure that SD appears on the LCD display.

d On the scanner’s control panel, press Menu.

e Press  or  until FMT is displayed on the LCD.

f Press Start / OK.

g Do one of the following:
• To format the SD card, press  or  to select YES, and then press Start / OK.

The SD icon and FMT in the LCD display blinks, and the scanner will begin to format the SD card. 
When the LCD displays OK, formatting is complete.

• To cancel formatting, press  or  to select NO, and then press Start / OK.

Changing the scan resolution (DS-920DW only)

NOTE
For DS-820W: change the resolution using your scanner’s HQ / STD ( ) button.

a Turn on your scanner.

b On the scanner’s control panel, press Menu.

c Press  or  until DPI is displayed on the LCD.

d Press Start / OK.

e Press  or  to select 600 (600 dpi) or 300 (300 dpi).

f Press Start / OK.

g The LCD displays OK, indicating that the resolution has been set.
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Acceptable documents

Document Specifications 2

Standard Paper Length 1 side scan
3.5 to 32 in. (90 to 812.8 mm)

2 side scan (DS-920DW only)
3.5 to 16 in. (90 to 406.4 mm)

Width 2.2 to 8.5 in. (55 to 215.9 mm)

Weight 16 to 28 lb (60 to 105 g/m2)

To scan thinner documents, use the Carrier Sheet (see Loading 
the Carrier Sheet on page 16).

Maximum Number of Pages 1 page (1 sheet)

Standard Paper Size A4 8.3 × 11.7 in. (210 × 297 mm) 

A5 5.8 × 8.3 in. (148 × 210 mm) 

A6 4.1 × 5.8 in. (105 × 148 mm) 

A7 2.9 × 4.1 in. (74 × 105 mm) 

A8 2.0 × 2.9 in. (52 × 74 mm) 

B5 7.2 × 10.1 in. (182 × 257 mm) 

B6 5.0 × 7.2 in. (128 × 182 mm) 

B7 3.6 × 5.0 in. (91 × 128 mm) 

B8 2.5 × 3.6 in. (64 × 91 mm) 

Legal 8.5 × 14 in. (215.9 × 355.6 mm) 

Letter 8.5 × 11 in. (215.9 × 279.4 mm) 

Plastic Cards Length 1.57 to 3.4 in. (40 to 86 mm)

Width 1.57 to 3.4 in. (40 to 86 mm)

Standard Size (ISO) 3.37 × 2.13 × 0.03 in. (85.6 × 54.0 × 0.76 mm)

Material Plastic (PET)

Type Plastic card such as a driver’s license or an insurance card

Thickness Less than 0.031 in. (0.8 mm)

Maximum Number of Pages 1 page (1 sheet)

Receipts Length 1 side scan
3.5 to 32 in. (90 to 812.8 mm)

2 side scan (DS-920DW only)
3.5 to 16 in. (90 to 406.4 mm)

Width 2.2 to 8.5 in. (55 to 215.9 mm)

Thickness More than 0.016 in. (0.04 mm)

Maximum Number of Pages 1 page (1 sheet)
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Unacceptable documents

 Documents with paper clips or staples

 Documents with wet ink

 Fabrics, metallic sheets, overhead projector sheets

 Glossy or mirrored media

 Embossed plastic cards

 Documents that exceed recommended thicknesses

Documents recommended for use with the Carrier Sheet
Use the supplied Carrier Sheet when you scan the following:

 Documents with a carbon sheet attached on the back

 Documents written in pencil

 Documents narrower than 2.2 in. (55 mm) wide

 Documents shorter than 3.5 in. (90 mm) long

 Documents of uneven thickness, such as envelopes

 Documents with large wrinkles or curls

 Bent or damaged documents

 Documents that use tracing paper

 Documents that use coated paper

 Photographs (photographic paper)

 Documents printed on perforated paper

 Documents printed on unusually-shaped paper (not square or rectangle)

 Documents with photos, notes, or stickers affixed to them

 Documents that use carbonless paper

 Documents that use loose-leaf paper or any paper with holes in it

 Photographic negatives

For more information about using the Carrier Sheet when scanning, see Loading the Carrier Sheet on 
page 16.

CAUTION
To avoid cutting yourself, do not slide or scrape your hand or fingers along the edges of the Carrier Sheet.
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IMPORTANT
• Do not place the Carrier Sheet in direct sunlight or in an area subject to high temperatures and high 

humidity, or the Carrier Sheet may warp.

• Do not place large or heavy objects on the Carrier Sheet when it is lying flat.

• Do not bend or pull the Carrier Sheet. If it becomes damaged, it may not be acceptable for scanning, and 
should not be used.
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Loading a document

IMPORTANT
• Insert only one page into the scanner at a time. Insert the next page only after the first one is completely 

scanned. Inserting more than one page at a time may cause your scanner to malfunction.

• DO NOT pull on the document while it is feeding.

• DO NOT use paper that is curled, wrinkled, folded, ripped, stapled, paper clipped, pasted, or taped.

• DO NOT try to scan cardboard or fabric.

NOTE
• Make sure there is enough space behind the paper ejection slot. The scanned document is ejected from 

the rear of the scanner.

• Make sure documents that have ink or correction fluid on them are completely dry.

• Certain types of plastic cards may be scratched when scanned. To prevent damage to the card, we 
recommended using the Carrier Sheet. For more information, see Loading the Carrier Sheet on page 16.

a Set your document a face up in the feeder slot b and align the left edge of the page with the left edge 
of the feeder slot c.
To scan a plastic card a, set the card top edge first into the feeder slot b and align the left edge of the 
card with the left edge of the feeder slot c.
For DS-920DW: When you perform duplex scanning, insert the first page face up into the feeder slot.

b Slide the document guide d until it touches the right side of the document.

c Gently insert the document until you feel its top edge touch the inside of the scanner.

NOTE
If you insert a document while SD is displayed on the LCD, scanning begins automatically.

Scan Preparation 3

1

243 243

1
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Loading the Carrier Sheet

NOTE
Make sure documents that have ink or correction fluid on them are completely dry.

a Set the document you want to scan in the left corner of the Carrier Sheet and align the top of the 
document with the top left corner of the Carrier Sheet.

b Set the Carrier Sheet a, document face up, with the black edge first in the feeder slot b and align the 
left edge of the Carrier Sheet with the left edge of the feeder slot c.
For DS-920DW: When you perform duplex scanning, insert the first page face up into the feeder slot.

c Slide the document guide d against the right side of the Carrier Sheet.

d Gently insert the Carrier Sheet until you feel its top edge touch the inside of the scanner.

1

243
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Important Carrier Sheet tips

 To avoid document jams, do not load the Carrier Sheet upside down. For more information, see Loading 
the Carrier Sheet on page 16.

 To avoid document jams, do not put several small documents into the Carrier Sheet at the same time. 
Insert only one document into the Carrier Sheet at a time. 

 Do not write on the Carrier Sheet, as the writing may be seen in scanned documents. If the Carrier Sheet 
becomes dirty, wipe it with a dry cloth.

 Do not leave documents in the Carrier Sheet for extended periods of time, as the printing on the 
documents may bleed through onto the Carrier Sheet.



18

4

4

Scanning in SD mode

a Insert the SD card into the SD card slot.

NOTE
When you use your own SD card, you must format the SD card first. To format the SD card on your 
scanner, see Formatting an SD card on page 11.

b Turn on your scanner.

c Make sure that SD appears on the LCD display.

d If necessary, adjust the scanning settings by pressing the COLOR / MONO, PDF / JPG and COLOR / 
MONO, PDF / JPG, HQ / STD (DS-820W only), 2 side / 1 side (DS-920DW only) buttons on the control 
panel.

e Insert your document.

f Your scanner starts scanning automatically.
The Power button LED blinks green and SD blinks on the LCD.

g The scanned image is stored on the SD card.
Check if your document has been scanned correctly.

NOTE
To access the scanned images on the SD card, see Access Scanned Images on the SD Card on page 49.

Scan Using the Control Panel 4

DS-820W DS-920DW
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Installing the scanner driver and scanning software

For Windows® users

NOTE
• Make sure that your computer is ON and you are logged on with Administrator rights.

• DO NOT connect the Micro USB Cable yet.

• If your computer does not have a DVD-ROM drive, the supplied Brother installation disc does not contain 
drivers for your operating system, or you want to download manuals and utilities, visit your model page at 
support.brother.com 

a Insert the Brother installation disc into your DVD-ROM drive.

b When the Setup screen appears, click Install Scanner Driver and follow the on-screen instructions.

NOTE
• If the Brother screen does not appear automatically, go to My Computer (Computer), double-click the 

CD/DVD-ROM icon, and then double-click AutoRun.exe.

• When you install the scanner driver, DSmobileCapture (a scanning application) will be installed at the 

same time. For more information on using DSmobileCapture, see Using DSmobileCapture (for Windows®) 
on page 25.

Scan Using Your Computer 5

http://support.brother.com
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c Click Additional Applications to install any of the following applications during setup:
• Button Manager V2: document scanning and storing (in specified destinations)
• PaperPort™ 12SE: document scanning, editing and management
• Presto! BizCard 6: business card scanning, editing and management
• BR-Receipts: receipt scanning, editing and management

NOTE
• To register your product and download BR-Receipts, click Download BR-Receipts to access the Brother 

Online site at www.brother.com/product/brotheronline. The applications available may differ depending on 
your country.

• For more information on which scanning application will work best for you, see Choosing your scanning 
software on page 24.

http://www.brother.com/product/brotheronline/
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For Macintosh users

NOTE
• Make sure that your computer is ON and you are logged on with Administrator rights.

• DO NOT connect the Micro USB Cable yet.

• If your computer does not have a DVD-ROM drive, the supplied Brother installation disc does not contain 
drivers for your operating system, or you want to download manuals and utilities, visit your model page at 
support.brother.com 

a Insert the Brother installation disc into your DVD-ROM drive.

b Double-click on the DVD icon, and then double-click DS-820W (DS-920DW).

c Double-click on Brother DS-820W (DS-920DW) and follow the on-screen instructions to install the 
scanner driver.

NOTE
When you install the scanner driver, DSmobileCapture (a scanning application) will be installed at the 
same time. For more information on using DSmobileCapture, see Using DSmobileCapture (for Macintosh) 
on page 35.

http://support.brother.com
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d Click one of these folders to install the following applications during setup:
• Presto! PageManager 9: document scanning, editing and management
• Presto! BizCard 6: business card scanning, editing and management
• BR-Receipts: receipt scanning, editing and management

NOTE
• Clicking Presto! PageManager or Presto! BizCard will open NewSoft Technology Corporation’s website. 

Download the application from this website.

• To register your product and download BR-Receipts, double-click BR-Receipts to access the Brother 
Online site at www.brother.com/product/brotheronline. The applications available may differ depending on 
your country.

• For more information on which scanning application will work best for you, see Choosing your scanning 
software on page 24.

http://www.brother.com/product/brotheronline/
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Connecting your scanner to your computer in TWAIN Mode

Before scanning a document using the scanning software, select TWAIN Mode on your computer.

a Turn on your scanner.

b Confirm that the Wi-Fi® switch is set to OFF.

c Connect the Micro USB Cable to the Micro USB port on your scanner. Connect the cable to your computer.

d Press the Start / OK button on the scanner to display PC on the LCD.
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Choosing your scanning software

After downloading the scanner drivers, select a scanning software application for saving scanned images to 
your computer. Use the following table to choose the scanning applications you want from those supplied on 
the Brother installation disc:

NOTE
• Clicking Presto! PageManager or Presto! BizCard will open NewSoft Technology Corporation’s website. 

Download the application from this website.

• To register your product and download BR-Receipts, double-click BR-Receipts to access the Brother 
Online site at www.brother.com/product/brotheronline. The applications available may differ depending on 
your country.

Software Function For more information

DSmobileCapture Document scanning, browsing and filing For Windows®: See Using DSmobileCapture 
(for Windows®) on page 25.

For Macintosh: See Using DSmobileCapture 
(for Macintosh) on page 35.

Button Manager V2
(Windows® only)

Document scanning and storing (in 
specified destinations)

See the software’s user instructions or 
Using Button Manager V2 (for Windows®) 
on page 41.

Nuance PaperPort™ 12SE
(Windows® only)

Document scanning, OCR scanning, 
editing and management

See the software’s user instructions.

Presto! PageManager 9
(Macintosh only)

Document scanning, OCR scanning, 
editing and management

See the software’s user instructions.

Presto! BizCard 6 Business card scanning, editing and 
management

See the Presto! BizCard User’s Manual 
which will be installed to your computer 
when you download the software.

BR-Receipts Receipt scanning and management See the software’s user instructions.

http://www.brother.com/product/brotheronline/
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Using DSmobileCapture (for Windows®)

a Connect the supplied Micro USB Cable to the Micro USB port on your scanner. Connect the cable to 
your computer.

b Double-click the DSmobileCapture shortcut  on your desktop.

c The Select Scanner Model dialog box appears. Select TWAIN under Driver Type and select Brother 
DS-820W (DS-920DW) under Scanner Model, and then click OK.

d DSmobileCapture launches.

e Change the scanning settings, if needed.

For more information on changing settings, see Changing DSmobileCapture scan settings (for Windows®) 
on page 27.
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f Insert a document into your scanner.

g Click Scan . Your scanner starts scanning.

A thumbnail of the scanned image appears in the DSmobileCapture screen and the scanned image will 
be saved in the directory you specified in step 5.
Check if your document has been scanned correctly.

h For continuous scanning, insert the next document into the scanner when Waiting for next job... screen 
appears. When you insert the document, scanning will start automatically. 
To stop the continuous scanning, click Cancel on Waiting for next job... screen.

NOTE
• To change the time delay when waiting for the next job, see Paper settings on page 29.

• To save multiple documents as one file, select Multi-page PDF or Multi-page TIFF from the File Format 
drop-down list.
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Changing DSmobileCapture scan settings (for Windows®)

File settings

(1) Setup Change scanner properties.

(2) File Format Change the file format.

Select the format you want from the drop-down list.

(3) Path Specify the directory where you want to save scanned images.

(4) Fit Page You can view and zoom the scanned image.

You cannot use Fit Page when PDF or Multi-page PDF is selected in File Format.

(5) Actual Size (100%) You can view the scanned image in Actual Size (100%).

You cannot use Actual Size (100%) when PDF or Multi-page PDF is selected in 
File Format.

(2)(1) (3) (4) (5)
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Image settings

Click Setup , and then click the Image tab to choose image type and to set basic scan settings.

NOTE
This image is from the DS-920DW.

(1) Image Selection Box Select the type of document you want to scan.

(2) Duplex (DS-920DW only) Select the Duplex check box to perform Duplex (2 side) scanning. 

(3) Brightness Adjusts the lightness or darkness of an image. The range is from -100 to +100. The 
factory setting is 0.

(4) Contrast Adjusts the range between the darkest and the lightest shades in the image. The 
range is from -100 to +100. The factory setting is 0.

(5) Resolution Determine the quality of the scanned image. The factory setting is 200 dpi.

(6) Invert Reverse the brightness and the colors in the image.

(7) Profiles Save or change the scanning setting in the dialog box of Scanner Properties.

(8) Defaults Reset values in this and all other Properties tabs to the original factory settings.

(1)
(6)

(3)

(4)

(5)

(8)

(2)
(7)
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Paper settings

Click Setup , and then click the Paper tab to define values related to image output.

(1) Cropping Cropping allows you to capture a portion of the scanned document.

 Automatic 

Select Automatic to allow the software to adjust the cropping window according 
to the document size. Use this option for batches of mixed-sized documents.

 Fix for Transfer 

Select Fix for Transfer if you want the ability to define the area or zone to be 
scanned. Use for batches of same-sized documents.

(1)

(2)

(3)

(5)

(6)

(7)

(4)
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(2) Scan Area Select your paper size from the drop-down list or create a custom paper size by 
clicking Add in the drop-down list.

If you selected Fix for Transfer in Cropping (1), define the X-Offset and Y-Offset 
or specify Width and Length to redefine the scan area. The Display Area (4) in 
this screen displays image placement as you change the values.

• X-Offset - the distance from the left edge of the document to the left edge of the 
scanned area.

• Y-Offset - the distance from the top edge of the document to the top edge of the 
scanned area.

• Width - the width of the scanned area.

• Length - the length of the scanned area.

• Use these arrows (or your mouse) to move the scan area; you can view 

the results in the Display Area of this screen.

(3) Adjustment Adjustment allows you to add a specific margin at left, right, top and bottom of 
your image. This may help to reduce possible corner clipping on any skewed 
images. Select a value from 0 to +5 mm. The Adjustment result will not appear in 
the Display Area.

(4) Display Area Displays image placement as you change the values in Scan Area (2).

(5) Unit Unit allows you to define your preferred measurement system. Select Inches, 
Millimeters, or Pixels from the drop-down list.

(6) Transfer Timeout Transfer Timeout allows you to set the amount of time (in seconds) the scanner 
will wait before starting automatic scan after the first scan job is completed. Use 
this setting when you have many separate documents that need to be scanned 
with the same scan settings. The default time is 30 seconds.

The value ranges from 0 to 60 seconds.

(7) Defaults Reset values in this and all other Properties tabs to the original factory settings.
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Preview settings

Click Setup , and then click the Preview tab to preview your image before the final scan so that you 

can set your scan area correctly.

NOTE
If you select Automatic cropping, in the Paper tab screen, you cannot preview your scan on this screen.

(1) Preview Window When you click Preview (3), the scanned image will appear in this area. This preview 
image lets you define your scan area.

(2) Defaults Reset values in this and all other Properties tabs to the original factory settings.

(3) Preview Click to start the preview scan. The scanned image will appear in the Preview Window (1). 
Note that the scanned image is only for the preview and will not be saved.

(3)

(1)

(2)
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Options settings

Click Setup , and then click the Options tab to set additional image processing settings or calibrate 

your scanner.

NOTE
This image is from the DS-920DW.

(1) Flip Side Rotation 
(DS-920DW only)

 Book 

Select Book to maintain the same image orientation on the reverse side of the 
output page.

 Fanfold 

Select Fanfold to rotate the image orientation 180 degrees on the reverse side of 
the output page.

(2) Rotation Select the rotation angle from the drop-down list if you want to rotate your scanned 
image.

(3) Calibration Calibrate the scanner.

For more information, see Calibration using software (for Windows®) on page 62.

(4) Defaults Reset values in this and all other Properties tabs to the original factory settings.

(2)

(3)

(4)

(1)
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Imprinter settings

Click Setup , and then click the Imprinter tab to print alphanumeric characters, date, time, document 

count and custom text on your scanned images.

(1) Digital Imprinter Select Digital Imprinter to print the message on the front of your scanned image.

(2) Print All Select the Print All check box to print your print string (message) on all pages of 
your document. Clear the Print All check box to print the print string on the first 
page only.

(3) Custom Type the text you want to print.

(4) Counter Displays the page count for the scan session.

(5) Date / Time Select a format from the drop-down list if you want to include the date and time in 
your print string.

(6) Custom Font Click the drop-down list to select a font for your print string.

(7) Font Attributes Select a font attribute from the drop-down list. Options include Normal, Underline, 
Double, or Bold.

(8) String Orientation Select a print string orientation from the drop-down list. Options include Normal, 
Rotated, Vertical, Vertical Inversion, 90 Degrees CW or 90 Degrees CCW.

(9) Print Position Select the position of your print string from the drop-down list. Options include 
Top, Middle, Bottom, or Custom. If you select Custom, enter the X Offset and 
Y Offset values to specify the position.

(10) More Click More... to set Size, Density and Transparency for your print string.

(11) Defaults Reset values in this and all other Properties tabs to the original factory settings.

(2)
(3)

(1)

(4) (5)
(6)

(11)

(7)
(8) (9)

(10)
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Information

Click Setup , and then click the Information tab to view system and scanner information.
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Using DSmobileCapture (for Macintosh)

a Connect the supplied Micro USB Cable to the Micro USB port on your scanner. Connect the cable to 
your computer.

b Double-click the DSmobileCapture shortcut  on your desktop.

c DSmobileCapture launches.

d Change the scanning settings, if needed.
For more information on changing settings, see Changing DSmobileCapture scan settings (for Macintosh) 
on page 36.

e Insert a document into your scanner.

f Click Scan in the DSmobileCapture screen when the document is set.
Your scanner starts scanning. The scanned image will be saved in the directory you specified in step 4.
Check if your document has been scanned correctly.
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Changing DSmobileCapture scan settings (for Macintosh)

Image settings

Click the Image tab to choose image type and to set several basic scan settings.

NOTE
This image is from the DS-920DW.

(1) Image Selection Box Select the type of document you want to scan.

(2) Duplex (DS-920DW only) Select the Duplex check box to perform Duplex (2 side) scanning. 

(3) Brightness Adjusts the lightness or darkness of an image. The range is from -100 to +100. 
The factory setting is 0.

(4) Contrast Adjusts the range between the darkest and the lightest shades in the image. 
The range is from -100 to +100. The factory setting is 0.

(5) Resolution Determine the quality of the scanned image. The factory setting is 200 dpi.

(6) Invert Reverse the brightness and the colors in the image.

(7) Page Size Page Size allows you to capture a portion of the scanned document. Select your 
paper size from the Page Size pop-up list.

(8) Profiles Save or change the scanning setting in the dialog box of Scanner Properties.

(9) Default Reset values in this and all other Properties tabs to the original factory settings.

(10) Preview Window Click to preview your image before final scan. This preview image lets you define 
your scan area.

When you click Preview, scanning for the preview starts and the scanned image 
will appear in the Preview Window. Note that the scanned image is only for the 
preview and will not be saved.

(1)

(7)

(8)

(3)

(4)

(5)

(6)

(10)(9)

(2)
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File settings

Click the File tab to configure the settings related to the file name and the directory where you want to save 
the scanned image.

(1) Directory Specify the directory where you want to save scanned images.

(2) File Name Set the rule for the file name of the scanned image.

(3) Digits Determine the starting number of the sequence number that is included in the file 
name.

(4) Sample Preview the file name that you set.

(5) When file names are the 
same

Change the file name if the same name already exists in the directory you selected 
in Directory.

(6) File Format Select the file format for the scanned image.

When you select TIFF or PDF, the Multi Page Output option is available.

You can continue to scan the next document after the first scan job is completed.

(7) Scan to Select the destination to send the scanned image.

(8) Default Reset values in this and all other Properties tabs to the original factory settings.

(9) Preview Window Click to preview your image before final scan. This preview image lets you define 
your scan area.

When you click Preview, scanning for the preview starts and the scanned image 
will appear in the Preview Window. Note that the scanned image is only for the 
preview and will not be saved.

(1)

(2)

(4)

(5)

(6)

(7)

(8)

(3)

(9)
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Paper settings

Click the Paper tab to define values related to image output.

(1) Page Size Page Size allows you to capture a portion of the scanned document.

Select your paper size from the Page Size pop-up list, define the X Offset and 
Y Offset values or specify Width and Length to define your scanned area. Click 
Preview Window (4) to preview image placement as you change the values.

• X Offset - the distance from the left edge of the document to the left edge of the 
scanned area.

• Y Offset - the distance from the top edge of the document to the top edge of the 
scanned area.

• Width - the width of the scanned area.

• Length - the length of the scanned area.

(2) Unit Unit allows you to define your preferred measurement system. Select Inches, 
Millimeters, or Pixels from the pop-up list.

(3) Default Reset values in this and all other Properties tabs to the original factory settings.

(4) Preview Window Click to preview your image before final scan. This preview image lets you define 
your scan area.

When you click Preview, scanning for the preview starts and the scanned image 
will appear in the Preview Window. Note that the scanned image is only for the 
preview and will not be saved.

(1)

(3)

(2)

(4)
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Options settings

Click the Options tab to set some additional image processing settings or calibrate your scanner.

(1) Rotation Degrees Select the rotation angle from the pop-up list if you want to rotate your scanned 
image.

(2) Mirror Select the Mirror check box to reverse your image.

(3) Calibration Calibrate the scanner.

For more information, see Calibration using software (for Macintosh) on page 65.

(4) Default Reset values in this and all other Properties tabs to the original factory settings.

(5) Preview Window Click to preview your image before final scan. This preview image lets you define 
your scan area.

When you click Preview, scanning for the preview starts and the scanned image 
will appear in the Preview Window. Note that the scanned image is only for the 
preview and will not be saved.

(1)
(2)

(3)

(4) (5)
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Information

Click the Information tab to view system and scanner information.

(1) Language Select the language you want to display from the pop-up list.

(1)
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Using Button Manager V2 (for Windows®)

NOTE
• For more detailed instructions, see the Button Manager V2 User’s Guide from the application’s help menu.

• To see the help menu, right-click the Button Manager V2 icon  on the system tray, and then click Help.

To open the Button Manager V2 Button Panel, use one of the following methods:

To display the shortcut icon and launch the Button Manager V2 Button Panel from your 
system tray

a Connect the Micro USB cable to the Micro USB port on your scanner. Connect the Micro USB cable to 
a USB port on your computer.

b Click the Button Manager V2 icon  on the system tray at the bottom right corner of your computer 
screen.

c The Button Manager V2 Button Panel launches.
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To launch the Button Manager V2 Button Panel from the Windows® Start button

a Click Start  > All Programs > Brother DS-820W (DS-920DW) Scanner > Button Manager > 

Button Manager V2.

b When the Select Scanner Model dialog box appears, select your scanner model from the list, and then 
click OK. 

c The Button Manager V2 Button Panel launches.
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Scanning methods

There are two ways to scan using Button Manager V2. If necessary, check or change scan settings before 
scanning.

To scan using the scan button on the Button Manager V2 Button Panel

a Insert a document into your scanner.

b Launch the Button Manager V2 Button Panel.

c If necessary, right-click the scan button you want in the Button Manager V2 Button Panel to change 
scan settings.
For more information, see the Button Manager V2 User’s Guide.

d Click the scan button you want to use in the Button Manager V2 Button Panel to start scanning.

To scan using the Start button on your scanner

a Insert a document into your scanner.

b Launch the Button Manager V2 Button Panel.

c If necessary, right-click the scan button you want in the Button Manager V2 Button Panel to change 
scan settings.
For more information, see the Button Manager V2 User’s Guide.

d Select the check box to the left of the scan button you want to use.

e Press the Start button on your scanner to start scanning.
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Scan buttons in the Button Manager V2 Button Panel 
(for Windows®)

Scan to an image

Use this option to open the scanned image in a specific application. Note that the application must already 
be open and running on your computer. 

To change scan settings, right-click the Scan  button (see the Button Manager V2 

User’s Guide).

a Insert a document into your scanner.

b Launch the Button Manager V2 Button Panel.

c Click Scan .

When scanning is complete, the scanned image will be inserted into your open and running application.
Check if your document has been scanned correctly.

NOTE
• If no application launches or the application is minimized, the scanned image will be saved in a predefined 

folder (for more information about changing the folder path, see the Button Manager V2 User’s Guide).

• If two or more applications are open, the scanned image will appear in the active application.

Scan to an application

Use this option to open the scanned image with a application that you choose from a list. 

To change scan settings, right-click the Scan To App  button.

a Insert a document into your scanner.

b Launch Button Manager V2 Button Panel.

c Click Scan To App  to start scanning.

When scanning is complete, the scanned image will be opened with the application you selected from 
the displayed list.
Check if your document has been scanned correctly.
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Scan to an email

Use this option to attach the scanned image to an email. 

To change scan settings or email software, right-click the E-mail  button.

a Insert a document into your scanner.

b Launch Button Manager V2 Button Panel.

c Click E-mail  to start scanning.

When scanning is complete, your email software launches and the scanned image will be attached to a 
blank email.
Check if your document has been scanned correctly.

Scan to a printer

Use this option to print the scanned image from your default printer. 

To change scan settings or destination printer, right-click the Printer  button.

a Insert a document into your scanner.

b Launch the Button Manager V2 Button Panel.

c Click Printer  to start scanning.

When scanning is complete, the scanned image will be printed from your default printer.
Check if your document has been scanned correctly.

Scan to shared folder

Use this option to save the scanned image in a shared folder on your network. 

To change scan settings, right-click the Shared Folder  button.

a Insert a document into your scanner.

b Launch the Button Manager V2 Button Panel.

c Click Shared Folder  to start scanning.

When scanning is complete, the scanned image will be sent directly to the shared folder.
Check if your document has been scanned correctly.
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Scan to a FTP server

Use this option to save the scanned image in a folder on your FTP server. 

To change scan settings, right-click the FTP  button.

a Insert a document into your scanner.

b Launch the Button Manager V2 Button Panel.

c Click FTP  to start scanning.

When scanning is complete, the scanned image will be sent directly to the folder on your FTP server.
Check if your document has been scanned correctly.
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Connecting in access point (AP) mode

You can connect your wireless device (computer, smartphone, tablet, or similar) to your scanner. Your scanner 
itself can be the access point without going through any other access point, and your wireless device can access 
the scanned images stored on the SD card directly.

NOTE
• If you have not set a Wi-Fi® network password, be sure to set up a network password in your web browser 

first. For more information, see Setting a Wi-Fi® network password on page 49.
• Without a Wi-Fi® network password, data on your SD card or network can be viewed and stolen by a third party.
• If you forget your password, press the scanner’s RESET button to reset the password. For more information, 

see Reset network settings on page 55.
• Up to three wireless devices can connect to your scanner at a time.

1 Slide the Wi-Fi® switch to ON.
Wait for about 40 seconds until the Wi-Fi® indicator changes from red to blue.

2 Activate the Wi-Fi® function of your wireless device (computer, smartphone, tablet, or similar) to select 
the scanner.
For more information, see the instructions provided with your wireless device.

3 Select the scanner’s SSID, Brother DS-820W-xxxx (where xxxx is your scanner’s Media Access 
Control (MAC) address).

Wi-Fi® Connection 6
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Connecting in infrastructure mode

NOTE
To connect to the scanner, you need to configure Wi-Fi settings in infrastructure mode. For more 
information, see Configuring Wi-Fi® settings in infrastructure mode on page 56.

You can connect your wireless device (computer, smartphone, tablet, or similar) to your scanner via an 
access point, and your wireless device can access the scanned images stored on the SD card directly.

1 Slide the Wi-Fi® switch to ON.
Wait for about 40 seconds until the Wi-Fi® indicator light changes from red to blue and then it changes 
to orange if the target's setting is set.

2 Activate the Wi-Fi® function of your wireless device, and then select the access point you want.
For more information, see the instructions provided with your wireless device.
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Using your web browser

You can use your wireless device’s (computer, smartphone, tablet, or similar) web browser to view the 
scanned images stored on the scanner’s SD card and download the scanned images to your wireless device.

a Connect your wireless device to your scanner.
For Access Point mode, see Connecting in access point (AP) mode on page 47.
For infrastructure mode, see Connecting in infrastructure mode on page 48.

b Launch your wireless device’s web browser.

c (For Access Point mode)
Type http://10.10.100.1 in the address bar.
(For infrastructure mode) 
Type your scanner’s IP address. If you do not know the IP address, see Configuring Wi-Fi® settings in 
infrastructure mode on page 56.

d When you view the scanned image in the browser for the first time, the Password Setup screen 
appears. Set your password, and then click Apply.
If you have already set the password, type the password to log on.

e The home screen appears in the browser.

NOTE
Images will not appear when there is no data on the SD card.

Setting a Wi-Fi® network password

If you have not set a Wi-Fi® network password, we recommend setting up a network password in your web 
browser first. Without a Wi-Fi® network password, data on your SD card or network can be viewed and stolen 
by a third party.

a Connect your wireless device to your scanner.
For Access Point mode, see Connecting in access point (AP) mode on page 47.
For infrastructure mode, see Connecting in infrastructure mode on page 48.

b Launch your wireless device’s web browser.

c (For Access Point mode)
Type http://10.10.100.1 in the address bar.
(For infrastructure mode) 
Type your scanner’s IP address. If you do not know the IP address, see Configuring Wi-Fi® settings in 
infrastructure mode on page 56.

d When you view the scanned image in the browser for the first time, the Password Setup screen 
appears. Set your password, and then click Apply.
If you have already set the password, type the password to log on.

Access Scanned Images on the SD Card 7
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e The home screen appears in the browser.

f Click Settings > Wi-Fi Access Point Mode. The Wi-Fi Access Point Mode screen appears.

g Select WPA2(AES) from the Encryption drop-down list.

h Type your Pre-shared Key, and click Apply.

i The Rebooting... screen appears, and the settings are completed.
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(1) Mode Click to switch between the type of scanned images to display (PDF or JPEG).

(2) Select All Click to select all check boxes.

(3) Download Click to download the selected files.

(4) Delete Click to delete the selected files.

(5) Settings Click to go to the settings pages. For more information, see Changing Settings 
Using Your Browser on page 54.

(6) Thumbnail view Displays the scanned images (up to 15 images per screen). When you double-click 
the scanned image in the thumbnail view, the preview screen will appear.

If there are no scanned images on the SD card, no thumbnails will be displayed.

(7) On-screen cursors 

Click to go to the first page.

Click to go to the previous page.

Click to go to the next page.

Click to go to the last page.

(8) Page Displays the number of the current page and the total number of pages.

(6)

(1) (2) (3) (4)

(5)

(7) (7)(8)
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Using the USB connection between your scanner and computer

NOTE
You cannot view the contents of the SD card when the Wi-Fi® switch is ON or your computer is in TWAIN 
mode.

For Windows®

a Connect the Micro USB cable to the Micro USB port on your scanner. Connect the cable to your computer.

b Click Start  > Computer, and then double-click Removable Disk.

c Double-click DCIM.
The folders on the SD card appear.
• 100PHOTO folder

Stores the scanned images in JPEG format. 
• 200DOC folder

Stores the scanned images in PDF format.

For Macintosh

a Connect the Micro USB cable to the Micro USB port on your scanner. Connect the cable to your computer.

b iPhoto launches automatically, and the scanned images on the SD card will appear.
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Using Avision (miwand) (Android™)

You can use your Android™ device’s applications to view scanned images stored on the scanner’s SD card 
and move scanned images to the Android™ device.

Install the app on your device from Google Play. To download, install, or uninstall the Android™ application, 
see the instructions provided with your device.

NOTE
• If you have not set a Wi-Fi® network password, be sure to set up a network password in your web browser 

first. For more information, see Setting a Wi-Fi® network password on page 49.

• Without a Wi-Fi® network password, data on your SD card or network can be viewed and stolen by a third 
party.

Using Avision (miwand) (iOS)

You can use your iOS device’s applications to view scanned images stored on the scanner’s SD card and 
move scanned images to the iOS device.

Install the app on your device from the App Store. To download, install, or uninstall the iOS application, see 
the instructions provided with your device.

NOTE
• If you have not set a Wi-Fi® network password, be sure to set up a network password in your web browser 

first. For more information, see Setting a Wi-Fi® network password on page 49.

• Without a Wi-Fi® network password, data on your SD card or network can be viewed and stolen by a third 
party.
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Configuring Wi-Fi® settings in access point (AP) mode

Configure network settings

You can configure network settings in your browser.

a Access the browser in AP mode.
For more information, see Connecting in access point (AP) mode on page 47.

b Click Settings.

Changing Settings Using Your Browser 8

(1) Wi-Fi Access Point Mode Set the SSID (network name) and Pre-Shared Key.

(2) Admin Password Set the password to log on.

(3) System Status Check the status of the current access point.

Check the IP address.

Check the firmware version.

(4) Home Return to the Home screen.

(5) Wi-Fi Infrastructure Mode Set the infrastructure mode settings.

(1) (2) (3)

(5)

(4)
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Reset network settings

You can reset the wireless network settings (Wi-Fi® AP Setting and Password Setup) back to the factory 
settings.

a Confirm that the scanner is turned on.

b Set the Wi-Fi® switch to ON. 

Wait about 40 seconds until the Wi-Fi® indicator turns from red to blue.
When your scanner makes a connection to your access point the Wi-Fi® indicator starts blinking blue or 
orange.

c Press and hold the scanner’s reset button (1) using a pointed object, such as a needle or a fine-point 
pen for 15 seconds.

d Release the reset button. The Wi-Fi® indicator will turn red and the Wi-Fi® network settings will be 
restored to the factory settings.

NOTE
When you press the reset button, any settings controlled by the buttons on the control panel will not be 
restored to the factory settings and any scanned images on the SD card will not be deleted.

(1)
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Configuring Wi-Fi® settings in infrastructure mode

Configure network settings for scanner

You can configure network settings in your browser.

a Access the browser in AP mode.
For more information, see Connecting in access point (AP) mode on page 47.

b Click Wi-Fi Infrastructure Mode.
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c Click IP Address.

d Select WAN Mode and type IP Address, Subnet Mask, Default Gateway and DNS.
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Configure network settings for your access point

You can configure network settings in your browser.

a Access the browser in AP mode.
For more information, see Connecting in access point (AP) mode on page 47.

b Click Wi-Fi Infrastructure Mode.

c Click Wi-Fi Network.
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d When you click the Auto button, available wireless networks appear.

When you click Manual button, type the SSID, Security and Password.
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Check the scanner’s IP address

a Access the browser in AP mode.
For more information, see Connecting in access point (AP) mode on page 47.

b Click System Status.

c Check if Connected is listed in the State field under Wi-Fi Access Assignment. If not, go back to 
page 56 to configure the settings.

d Check the IP Address under Wi-Fi Access Assignment.

NOTE
The IP address is required when connecting in Infrastructure mode to the scanner in infrastructure mode 
from your computer or mobile device.
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Calibrate your scanner only if the scanned images start to look fuzzy, the color looks abnormal (darker than 
normal), after 8,000 scans, or if the scanner has been stored without being used for a long time. 

You will need the Calibration Sheet that came with your scanner to successfully perform calibration.

Calibration using the control panel

a Turn on your scanner.

b Press the Menu button.

c Press the  or  button repeatedly to select CAL on the LCD.

d Hold the edges of the Calibration Sheet and insert it into the feeder slot as shown below.

NOTE
Hold only the edges of the calibration sheet and be careful not to touch the white or black areas. Leaving 
marks or fingerprints on this sheet can cause errors in calibration.

Scanner Calibration 9
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e Press the Start / OK button.

f The scanner starts feeding the calibration sheet. The Power button LED blinks green.

g After the calibration sheet is ejected, OK appears on the LCD and calibration is finished.

Calibration using software (for Windows®)

a Double-click the DSmobileCapture shortcut  on your desktop.

b The Select Scanner Model dialog box appears. Select TWAIN under Driver Type, select 
Brother DS-820W (DS-920DW) under Scanner Model, and then click OK. 

c DSmobileCapture launches.

d Click Setup .
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e Click the Options tab.

f Click Calibration to start calibrating the scanner.

g A message appears, prompting you to insert the Calibration Sheet.
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h Hold the edges of the Calibration Sheet and insert it into the feeder slot as shown below. 
Click Yes.

NOTE
Hold only the edges of the Calibration Sheet and be careful not to touch the white or black area. Leaving 
marks or fingerprints on this sheet can cause errors in calibration.

i Scanning starts automatically.

j After the Calibration Sheet is scanned, the Calibration was successful message appears on your 
screen, indicating that calibration is finished. Click OK to end calibration, and then click OK to close the 
Options screen.

NOTE
If the Calibration failed message appears on your screen, remove the Micro USB cable from your 
computer. Reconnect the Micro USB cable to the computer and perform the calibration again.
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Calibration using software (for Macintosh)

a Double-click the DSmobileCapture shortcut  on your desktop.

b DSmobileCapture launches.

c Click the Options tab.

d Click Calibration to start calibrating the scanner.

e A message appears, prompting you to insert the Calibration Sheet.
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f Hold the edges of the Calibration Sheet and insert it into the feeder slot as shown below. 
Click OK.

NOTE
Hold only the edges of the Calibration Sheet and be careful not to touch the white or black area. Leaving 
marks or fingerprints on this sheet can cause errors in calibration.

g Scanning starts automatically.

h After the Calibration Sheet is scanned, the Calibration was successful message appears on your 
screen, indicating that calibration finished successfully. Click OK to end calibration.

NOTE
If the Calibration failed message appears on your screen, remove the Micro USB cable from your 
computer. Reconnect the Micro USB cable to the computer and perform the calibration again.
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IMPORTANT
Do not use any solvents or corrosive liquid, such as alcohol, kerosene, or similar, to clean any part of the 
scanner, or the plastic may be permanently damaged. 

Cleaning the outside of your scanner

To prevent dust accumulation, we recommend cleaning the exterior of your scanner periodically.

a Remove the Micro USB cable from both your scanner and your computer.

b Wipe the outside of the scanner with a dry, soft, lint-free cloth.
If necessary, wipe the exterior with a cloth lightly dampened with water or diluted detergent, and finish 
with a dry cloth.

c Reconnect the Micro USB cable to your scanner and your computer.

Cleaning the inside of your scanner

To maintain the scanned image quality, clean the interior of your scanner periodically. If vertical lines or 
stripes appear on scanned images, this indicates that it is time to clean your scanner.

a Remove the Micro USB cable from both your scanner and your computer.

b Open the scanner’s top cover.

Scanner Maintenance 10
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c Gently wipe the glass and feed rollers with the supplied cleaning cloth.

d Close the top cover.

e Reconnect the Micro USB cable to your scanner and your computer.
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IMPORTANT
For technical help, you must contact Brother customer support in the country where you bought the 
scanner. For more information, see For customer service on page 83. Calls must be made from within 
that country.

If you think there is a problem with your scanner, check the table below and follow the suggestions.

Most problems can be easily resolved by yourself. If you need additional help, go to the Brother Solutions 
Center at support.brother.com for more FAQs and troubleshooting tips.

Using non-Brother supplies may affect scan quality, hardware performance and product reliability.

Error messages and Error codes

Error messages

Troubleshooting 11

Error message Cause Action

Driver busy The scanning application in use 
crashed or the scanner driver is 
locked with administrator rights.

Press and hold the Power button to 
turn off the scanner, and then press 
the Power button to turn it on again. 
Then launch the application again.

A document is jammed. Open the top 
cover and remove the jammed paper 
by pulling it forward, then try again.

A document is jammed. Open the top cover and remove the 
document by pulling it forward, then 
close the top cover.

The cover of the manual document 
feeder is open.

Your scanner’s top cover is open. Close the top cover and start 
scanning again.

No paper in the manual document 
feeder

No document is set in the feeder slot. Set your document in the feeder slot 
and start scanning again.

Cannot find the scanner. Your scanner is not connected to 
your computer.

Confirm that the Micro USB cable 
connecting the scanner to the 
computer is connected correctly.

Your scanner is not turned on. Press the Power button to turn on 
the scanner.

Operation system return error Your Operating System cannot 
recognize your scanner.

 Confirm that the Micro USB cable 
connecting the scanner to the 
computer is connected correctly.

 Restart the computer.

http://support.brother.com
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Error Codes

Calibration failed. Please reboot the 
machine.

The calibration failed for some 
reason. For example, the Calibration 
Sheet is not inserted in the correct 
direction.

 Press and hold the Power button 
to turn off the scanner, and press 
the Power button to then turn it 
on again. Then, perform the 
calibration again.

 Insert the Calibration Sheet in the 
correct direction.

• To perform the calibration using 
the control panel, see Calibration 
using the control panel on 
page 61.

• For Windows®: to perform the 
calibration using software, see 
Calibration using software (for 
Windows®) on page 62.

• For Macintosh: to perform the 
calibration using software, see 
Calibration using software (for 
Macintosh) on page 65.

Error Code Items Description Root cause / Code Purpose How to restore

E03 Card full or Card Read / 
Write error

The SD card is full, protected, or 
corrupt; scanned images cannot be 
saved to the SD card.

Check the SD card’s protective 
switch, reinsert the SD card, or insert 
a new SD card.

E04 Paper Jam Your document exceeds the 
maximum length, and the scanner 
cannot successfully eject the 
scanned document.

Open the top cover and remove the 
document, then close the cover and 
try to scan again.

E05 Missing Scan Data Scanner does not detect a document 
in the document feeder slot.

Make sure the document is inserted 
correctly.

E06 Cover Open The scanner’s top cover is open, or 
the top cover sensor has failed.

Close the scanner’s top cover.

E19 Calibration Fail The scanner’s internal check failed 
because of a calibration data error.

Recalibrate the scanner.

• To perform the calibration using the 
control panel, see Calibration using 
the control panel on page 61.

• For Windows®: to perform the 
calibration using software, see 
Calibration using software (for 
Windows®) on page 62.

• For Macintosh: to perform the 
calibration using software, see 
Calibration using software (for 
Macintosh) on page 65.

Error message Cause Action
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Troubleshooting

Scanning difficulties

Difficulty Cause Suggestions

My scanner does not 
turn on.

The supplied Micro USB cable is not 
connected correctly.

Make sure the Micro USB cable is securely 
connected to your scanner and computer.

The battery is low. Connect the Micro USB cable to your scanner and 
computer to charge the battery.

If you charge the scanner’s battery only a little from 
empty battery, you cannot use the scanner. Turn off 
the scanner until the battery is charged fully.

My computer does not 
recognize the scanner 
when it is connected 
via the Micro USB 
cable.

Causes may vary. Make sure the Micro USB cable is securely 
connected to your scanner and computer. Remove 
the Micro USB cable and reconnect the Micro USB 
cable to your scanner and computer.

My scanned images 
have black lines 
running through them, 
blank spaces, or are of 
overall bad quality.

This problem occurs if the scanner is 
not calibrated correctly or if a foreign 
object, such as a paper clip or ripped 
paper, is stuck in the scanner.

1. Check the document feeder slot and make sure 
that the slot is clear. If foreign objects are found, 
remove them from your scanner.

2. Calibrate your scanner (see Scanner Calibration 
on page 61).

If scan quality is not improved after you calibrate 
your scanner:

1. Clean the scanner (see Scanner Maintenance on 
page 67).

2. Calibrate your scanner again.

My scanned image is 
missing.

The Document Guides are not adjusted 
to fit the width of the document.

Adjust the Document Guides to fit the width of the 
document.

The settings are not suitable for your 
document. For example, an A4 
document was fed when Letter was 
selected as the document size.

Make sure the document size settings are suitable 
for your document.

For Windows®: see Paper settings on page 29.

For Macintosh: see Paper settings on page 38.

The scan speed is too 
slow.

The resolution is not suitable for your 
document.

Decrease the scanner resolution.

For Windows®: see Image settings on page 28.

For Macintosh: see Image settings on page 36.
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My scanner is 
connected but it will 
not feed my document 
or do anything else.

Your document is not set correctly. Insert your document until you feel the top edge of 
the document touch the inside of your scanner.

Your document is too thin or too thick. Check that your document is acceptable (see 
Document Specifications on page 12).

If your document is not the problem:

1. Confirm that the Micro USB cable connecting your 
scanner to your computer is properly connected.

2. Reinstall the scanner driver from the Brother 
installation disc.

The scanner’s top cover is open. Close the top cover and start scanning again.

The scanner is turned off because the 
Auto Power Off function is active.

Press the Power button to turn on the scanner.

You are operating the settings menu. 
(SD mode only)

Exit the settings menu to put the scanner into 
standby mode.

No SD card is inserted in the scanner’s 
SD card slot. (SD mode only)

Insert an SD card into the scanner’s SD card slot.

The document is 
jammed.

Causes may vary. Open the scanner’s top cover and gently pull out 
the document. Make sure that no piece of paper 
remains in the scanner.

Your document is not acceptable for the 
scanner (for example, if the paper is too 
long).

 Make sure your document is acceptable for the 
scanner (see Document Specifications on 
page 12).

 Use the supplied Carrier Sheet (see Loading the 
Carrier Sheet on page 16).

My scanner gets 
warm.

It is normal for your scanner to emit a 
small amount of heat after prolonged 
use. 

If there is a strange smell coming from the scanner 
or the scanner feels a little bit hot to the touch, 
immediately disconnect the Micro USB Cable from 
your scanner and computer.

The scan quality is 
poor.

Paper dust has accumulated inside 
your scanner.

Clean your scanner (see Scanner Maintenance on 
page 67).

Calibration needs to be performed. Perform the calibration.

• To perform the calibration using the control 
panel, see Calibration using the control panel on 
page 61.

• For Windows®: to perform the calibration using 
software, see Calibration using software (for 
Windows®) on page 62.

• For Macintosh: to perform the calibration using 
software, see Calibration using software (for 
Macintosh) on page 65.

The scanner resolution is too low. Increase the scanner resolution.

For Windows®: see Image settings on page 28.

For Macintosh: see Image settings on page 36.

Difficulty Cause Suggestions
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Colors in the scanned 
image are dark.

The settings are not appropriate for the 
type of document being scanned.

Adjust the scanning settings.

For Windows®: see Image settings on page 28.

For Macintosh: see Image settings on page 36.

Calibration needs to be performed. Perform the calibration.

• To perform the calibration using the control 
panel, see Calibration using the control panel on 
page 61.

• For Windows®: to perform the calibration using 
software, see Calibration using software (for 
Windows®) on page 62.

• For Macintosh: to perform the calibration using 
software, see Calibration using software (for 
Macintosh) on page 65.

OCR feature does not 
work.

The scanner resolution is too low. Increase the scanner resolution.

For Windows®: use PaperPort™ 12SE to increase 
the resolution.

For Macintosh: use Presto! PageManager 9 to 
increase the resolution.

(Windows® users)

Nuance PaperPort™ 12SE has not 
been installed on your computer.

Make sure you have installed Nuance PaperPort™ 
12SE from the supplied Brother installation disc.

(Macintosh users)

Presto! PageManager has not been 
installed on your computer.

Make sure you have installed Presto! 
PageManager from the supplied Brother installation 
disc.

The scanned image is 
skewed (slanted).

The scanner’s Document Guides are 
not adjusted to fit the width of the 
document.

Adjust the Document Guides to fit the width of the 
document. 

White vertical lines or 
white stripes appear 
on the scanned image.

The scanner is in direct sunlight. • Move the scanner out of direct sunlight.

• Change the scanner’s orientation.

A light source is near the scanner. • Move the scanner away from the light source.

• Change the scanner’s orientation.

Difficulty Cause Suggestions
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Software difficulties

Bleed-through is seen 
in scanned images.

Your document is too thin. Check that your document is acceptable (see 
Document Specifications on page 12).

The contrast settings are incorrect. Increase the contrast level.

For Windows®: see Image settings on page 28.

For Macintosh: see Image settings on page 36.

When I want to scan in 
SD mode, is it possible 
to change the paper 
size, the image quality, 
etc. on my scanner?

Only certain settings are available. For more information about the settings, see step 4 
of Scanning in SD mode on page 18.

(DS-920DW only)

Duplex scanning 
cannot be performed.

Duplex scan settings are not configured 
in DSmobileCapture.

Launch DSmobileCapture, click the Image tab, 
and then select the Duplex check box.

The scan mode of the scanner is set to 
1 side (in SD mode).

Press the scanner’s 2 side / 1 side button so that 2 
appears on the LCD.

Difficulty Cause Suggestions

When I press Scan in my 
scanning software, an 
error message appears: 
Please install scanner or 
The scan was aborted 
because the scanner is 
not powered on or not 
connected properly.

This error message appears if your 
scanner is not recognized by your 
computer.

1. Make sure your scanner is connected correctly.

2. Confirm that the Micro USB cable is working and 
that it is not frayed or damaged in any way.

If the error still appears after verifying that the Micro 
USB cable is connected correctly, reinstall the 
scanner driver from the Brother installation disc.

I cannot install the scanner 
drivers.
(Windows®)

You may not have been given 
administrator privileges.

Log into Windows® with administrator rights.

I cannot install the scanner 
drivers. 
(Macintosh)

You may not have been given 
administrator privileges. 

From the Apple menu, select System Preferences 
> System > Users & Groups. The left pane of the 
window will list the current accounts, one of which 
should be your user name with the word “Admin” 
underneath. If this is not the case, contact your 
system administrator.

The file size is too large. The size of the file may depend on 
many factors, such as the physical 
size of the document and the 
amount of text / graphics on each 
page.

To produce the smallest scan file for a given 
document, use the lowest resolution and Black 
and White mode, and scan the smallest area 
possible. Using the opposite settings (scanned in 
the highest resolution, in the Color mode, and 
scanning the largest area possible) will produce the 
largest-sized file.

For Windows®: see Changing DSmobileCapture 
scan settings (for Windows®) on page 27).

For Macintosh: see Changing DSmobileCapture 
scan settings (for Macintosh) on page 36).

Difficulty Cause Suggestions
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Network difficulties

Difficulty Cause Suggestions

My wireless device 
(computer, 
smartphone, tablet, or 
similar) cannot access 
my scanner via the 
wireless LAN network 
in AP mode.

The Wi-Fi® switch of the scanner is set 
to OFF.

Set the Wi-Fi® switch to ON.

Four or more wireless devices are 
connected to your scanner at a time.

Disconnect the wireless devices that are already 
connected to the scanner. Then, try to connect no 
more than three wireless devices to the scanner.

Causes may vary. Set the Wi-Fi® switch to OFF, then set it to ON to 
reconnect the scanner.

I forgot the login 
password to enter the 
Home screen on the 
browser.

Causes may vary. Reset the network settings (see Reset network 
settings on page 55).

The Wi-Fi® indicator 
blinks red.

A system error has occurred. • Set the Wi-Fi® switch to OFF, then set it to ON.

• Press and hold the Power button to turn off the 
scanner, and press the Power button to turn on it.

• Reset the network settings (see Reset network 
settings on page 55).

• If the problem still appears after you tried the 
above suggestions, contact the Customer 
Service center in the country where you bought 
the scanner.

My scanner cannot 
connect to any access 
point.

The settings for the Infrastructure mode 
of the machine are incorrect.

1. Connect your computer to your scanner via 
Wi-Fi AP mode.

2. Launch your computer’s web browser.

3. Type http://10.10.100.1 in the address bar.

4. Click Settings > Wi-Fi Infrastructure Mode.

5. Configure the settings for the access point.

The settings for the access point are 
correct but the scanner cannot connect 
to any access point.

Do one of the following:

• Confirm that your access point is turned on.

• Turn your access point off and on again.

• Place the scanner in a service area.

• Set a new correct SSID and password.

• Use Infrastructure mode settings for your access 
point.

• When MAC address filtering is used for your 
access point, register the MAC address of the 
scanner.

• Set the Wi-Fi® switch to OFF and to ON again.

• Press and hold the Power button to turn off the 
scanner, and press the Power button to turn it on 
again.



Troubleshooting 

76

11

Other difficulties

I do not know the 
scanner’s SSID.

— The SSID is below (It is changeable):

Brother DS-820W-xxxx (Brother DS-920DW-xxxx) 
(xxxx shows the last four digits of your scanner’s 
MAC address (twelve-digits). The address is 
printed on your product label.)

My computer cannot 
connect to the scanner 
with the web browser.

— 1. Connect your computer to your scanner via 
Wi-Fi® (Connect in AP mode).

2. Launch your computer’s web browser.

3. Type http://10.10.100.1 in the address bar.

I do not know the 
scanner’s MAC 
address.

— See the initial password on the mark located on the 
bottom of your scanner.

I do not know the initial 
Wi-Fi® password.

— See the initial password on the mark located on the 
bottom of your scanner.

I cannot reset the 
network settings.

The Wi-Fi® switch is set to OFF. 1. Set the Wi-Fi® switch to ON.

2. Wait for 40 or more seconds.

3. Press and hold the scanner’s reset button for 
15 or more seconds.

4. Release the reset button. In several seconds, the 
Wi-Fi® indicator will turn red.

Difficulty Cause Suggestions

I do not have the 
Calibration Sheet.

Causes may vary. The special glossy calibration sheet that came with 
your scanner will give you the best calibration 
results. To order a new Calibration Sheet, find 
contact information for your local Brother office at 
www.brother.com 

I want to use a USB 
hub.

Causes may vary. Use your scanner without connecting to a USB hub. 
A USB hub may not be able to supply enough 
power to the scanner.

I cannot charge my 
scanner.

The scanner is on while you are trying 
to charge it.

Turn the scanner off when you charge it.

The Li-ion battery is not installed 
correctly.

Make sure the Li-ion battery is installed in the 
correct direction (see the Quick Setup Guide).

Difficulty Cause Suggestions

http://www.brother.com


Troubleshooting 

77

11

My scanner cannot be 
turned on or is turned 
off immediately.

The battery has not been inserted. Insert the battery.

The battery has been inserted in the 
wrong direction.

Insert the battery in the correct direction. For more 
information, see Installing the battery on page 9.

• The battery is empty.

• The battery is low.

• The scanner’s Wi-Fi® switch is ON.

Do one of the following:

• Set the Wi-Fi® switch to OFF to use the scanner.

• Connect the Micro USB cable to your scanner 
and your computer to use the scanner. If you 
cannot turn on the scanner when you press the 
Power button, wait for two minutes, and then 
press the Power button again.

• Turn off the scanner and connect the Micro USB 
cable to your scanner and your computer until 
the battery is charged fully. And then use the 
scanner.

When I set the Wi-Fi® 
switch to ON, the 
Wi-Fi® indicator does 
not turn on.

The battery is low. Connect the Micro USB cable to your scanner and 
your computer to charge the battery.

The Li-ion battery is not installed. Install the battery, and then charge it.

I lost the Li-ion battery 
or I cannot charge the 
battery.

Causes may vary. Find contact information at support.brother.com 

My computer cannot 
access the SD card via 
the Micro USB cable.

The Micro USB cable is not connected 
to your computer.

Connect the Micro USB cable to your scanner and 
your computer.

Your scanner is in TWAIN mode. Press the Start / OK button, and then display SD on 
the LCD to change to Mass Storage mode (SD 
mode).

The Wi-Fi® switch is set to ON. Set the Wi-Fi® switch to OFF.

A document is being scanned. When the scanning is finished, wait for the SD 
card’s folder to appear on your computer screen.

When I access the SD 
card using the web 
browser, scanned 
images stored on the 
scanner's SD card are 
not displayed on the 
home screen.

Your scanner is in TWAIN mode. Press the Start / OK button, and then display SD 
on the LCD to change to Mass Storage mode 
(SD mode).

Your scanner is scanning a document. Display the web browser again when scanning is 
complete.

Incorrect IP address. Go to page 60 and confirm the IP address.

My scanner cannot be 
set to TWAIN mode.

The scanner’s Wi-Fi® switch is ON. Set the Wi-Fi® switch to OFF (see Connecting your 
scanner to your computer in TWAIN Mode on 
page 23).

I set the auto power off 
function to ON but my 
scanner does not turn 
off automatically.

The Wi-Fi® switch is set to ON. Set the Wi-Fi® switch to OFF.

Difficulty Cause Suggestions

http://support.brother.com
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Specifications

NOTE
This chapter provides a summary of the scanner’s specifications. For additional specifications, go to your 
scanner’s product page at www.brother.com and click the Specifications tab.

General

1 Measured when the scanner is connected to your computer.

Appendix A A

DS-820W DS-920DW

Power Source USB bus-power / Li-ion battery

Power consumption 1 Scanning / Battery 
Charging

5 V / 500 mA or less

Battery full-charged 
/ Power Off

5 V / 1 mA or less

Dimensions Width 12.1 in. (308.0 mm) 

Height 1.6 in. (40.7 mm) 1.6 in. (41.2 mm)

Depth 2.1 in. (52.5 mm) 2.6 in. (66.9 mm)

Weight Approx. 0.97 lb (440 g) Approx. 1.17 lb (530 g)

Temperature Operating 41 to 95 °F (5 to 35 °C) 

Humidity Operating 15 to 85 %

Storage 10 to 90 %

Document Size Single Paper Width 2.2 to 8.5 in. (55 to 215.9 mm) 

Length 1 side scan
3.5 to 32 in. (90 to 812.8 mm)

- 2 side scan
3.5 to 16 in. 

(90 to 406.4 mm) 

http://www.brother.com/
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Scanner

1 Windows® XP in this User’s Guide includes Windows® XP Home Edition and Windows® XP Professional.

2 For the latest driver updates for the Mac OS X version you are using, visit us at support.brother.com and click “Downloads” from your model page.

DS-820W DS-920DW

Color / Mono Yes / Yes

Duplex Scan No Yes

TWAIN Compliant Windows® Windows® XP 1 / Windows Vista® / Windows® 7 / Windows® 8 / 
Windows® 8.1 / Windows® 10

Macintosh Mac OS X 10.6.x, 10.7.x, 10.8.x, 10.9.x, 10.10.x, 10.11.x 2

Color Depth Input 48 bit color Processing

Output 24 bit color Processing

Resolution Optical Up to 600 × 600 dpi

Interpolated 1200 dpi

Scanning Width Up to 8.5 in. (216 mm) 

Gray Scale Input 16 bit

Output 8 bit

Scanning Max. Speed Mono 8.0 ppm (7.5 seconds (Letter) up to 300 dpi)

7.5 ppm (8 seconds (A4) up to 300 dpi)

4.3 ppm (14.1 seconds (Letter) above 400 dpi)

4 ppm (15 seconds (A4) above 400 dpi)

Color 8.0 ppm (7.5 seconds (Letter) up to 300 dpi)

7.5 ppm (8 seconds (A4) up to 300 dpi)

4.3 ppm (14.1 seconds (Letter) above 400 dpi)

4 ppm (15 seconds (A4) above 400 dpi)

Duplex Scanning Max. Speed - Mono 5.3 ppm (11.3 seconds 
(Letter) up to 300 dpi)

5 ppm (12 seconds (A4) 
up to 300 dpi)

3 ppm (19.8 seconds 
(Letter) above 400 dpi)

2.9 ppm (21 seconds (A4) 
above 400 dpi)

Color 5.3 ppm (11.3 seconds 
(Letter) up to 300 dpi)

5 ppm (12 seconds (A4) 
up to 300 dpi)

3 ppm (19.8 seconds 
(Letter) above 400 dpi)

2.9 ppm (21 seconds (A4) 
above 400 dpi)

http://support.brother.com
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Li-ion battery

NOTE
• The numbers described in the Li-ion battery table may differ depending on the scanning document and on 

environmental factors, such as temperature and the charging and discharging method.

• For longer battery life:

- Set the Wi-Fi® switch to OFF when you are not using the Wi-Fi® function.

- Turn the scanner off when you are not using it.

Interfaces

1 Your scanner has a Hi-Speed USB 2.0 interface. The scanner can also be connected to a computer that has a USB 1.1 interface.

2 Third party USB ports are not supported.

Network

DS-820W DS-920DW

Charging time 4 hours

Continuous standby time (WLAN OFF) 5 minutes (when the auto power function is active)

Scannable number of sheets (WLAN ON) 90 sheets 140 sheets

Scannable number of sheets (WLAN OFF) 450 sheets 680 sheets

USB Hi-Speed USB 2.0 1, 2

Use a USB 2.0 cable (Type A / Micro-B) that is no more than 4 feet (1.2 meters) long.

SD card SD card memory size limit: between 2GB - 32GB

If you do not use the SD card supplied with your scanner, correct operation cannot be 
guaranteed.

Wireless LAN IEEE 802.11b/g/n

DS-820W DS-920DW

Network
(common)

Protocol (IPv4) ARP, DNS Resolver, HTTP, ICMP, DHCP with BOOTP

Network 
Security

Wireless SSL/TLS (HTTPS)

Wireless Network Security WEP 64/128 bit, WPA-PSK (AES), 
WPA2-PSK (AES)

WEP 64/128 bit, WPA-PSK 
(TKIP/AES), WPA2-PSK (AES)

Wireless Certification Wi-Fi Certification Mark License (WPA™/WPA2™, Personal)
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Computer requirements

For the latest driver updates, visit support.brother.com 

All trademarks, brand and product names are property of their respective companies.

SUPPORTED OPERATING SYSTEMS AND SOFTWARE FUNCTIONS

Computer Platform & 
Operating System Version

Processor Minimum 
Speed

Minimum 
RAM

Recommended 
RAM

Hard Disk Space to 
Install Supported 

PC 
InterfaceFor 

Drivers
For 

Applications

Windows® 
Operating 
System

Windows® XP 
Home

Windows® XP 
Professional

Intel® Core™ 2 Duo or 
equivalent

1 GB 2 GB 80 MB 1.2 GB USB

Windows® XP 
Professional x64 
Edition

64-bit (Intel® 64 
or AMD64) supported 
CPU

1 GB 2 GB

Windows Vista® Intel® Core™ 2 Duo or 
equivalent 64-bit 
(Intel® 64 or AMD64) 
supported CPU

1 GB 2 GB 80 MB 1.2 GB

Windows® 7 Intel® Core™ 2 Duo or 
equivalent 64-bit 
(Intel® 64 or AMD64) 
supported CPU

1 GB (32-bit)

2 GB (64-bit)

2 GB (32-bit)

4 GB (64-bit)

80 MB 1.2 GB

Windows® 8 Intel® Core™ i3 or 
equivalent 64-bit 
(Intel® 64 or AMD64) 
supported CPU

1 GB (32-bit)

2 GB (64-bit)

2 GB (32-bit)

4 GB (64-bit)

80 MB 1.2 GB

Windows® 8.1 Intel® Core™ i3 or 
equivalent 64-bit 
(Intel® 64 or AMD64) 
supported CPU

1 GB (32-bit)

2 GB (64-bit)

2 GB (32-bit)

4 GB (64-bit)

80 MB 1.2 GB

Windows® 10 Intel® Core™ i3 or 
equivalent 64-bit 
(Intel® 64 or AMD64) 
supported CPU

1 GB (32-bit)

2 GB (64-bit)

2 GB (32-bit)

4 GB (64-bit)

80 MB 1.2 GB

Macintosh 
Operating 
System

OS X 10.6.x Intel® Processor 1 GB 2 GB 80 MB 400 MB USB

OS X 10.7.x Intel® Processor 1 GB 2 GB

OS X 10.8.x Intel® Processor 2 GB 4 GB

OS X 10.9.x Intel® Processor 2 GB 4 GB

OS X 10.10.x Intel® Processor 2 GB 4 GB

OS X 10.11.x Intel® Processor 2 GB 4 GB

http://support.brother.com
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Contacting Brother

IMPORTANT
For technical help, you must contact Brother customer support in the country where you bought the 
scanner. For more information, see For customer service on page 83. Calls must be made from within 
that country.

 

Register your product

By registering your product with Brother International Corporation, you will be recorded as the original owner 
of the product. Your registration with Brother:

 may serve as confirmation of the purchase date of your product should you lose your receipt

 will help us notify you of enhancements to your product and special offers

Complete and fax the Brother Warranty Registration And Test Sheet or, for your convenience and most 
efficient way to register your new product, register online at

www.brother.com/registration 

Frequently asked questions (FAQs)

The Brother Solutions Center is our one-stop resource for all your Brother scanner needs. You can download 
the latest software documents and utilities, read FAQs and troubleshooting tips, and learn how to get the most 
from your Brother product.

support.brother.com 
You can check the Brother Solutions Center for Brother driver updates.

To keep your scanner performance up to date, check the Brother Solutions Center for the latest firmware 
upgrade.

Appendix B B
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For customer service

If you have comments or suggestions, please write us at:

Service center (USA only)

Visit www.brother-usa.com/service 

In USA: 1-877-BROTHER (1-877-276-8437)

1-901-379-1215 (fax)

For the location of a Brother authorized service center, call 1-877-BROTHER 
(1-877-276-8437).

In Canada: 1-877-BROTHER

(514) 685-4898 (fax)

For the location of a Brother authorized service center, call 1-877-BROTHER.

In USA: Printer Customer Support

Brother International Corporation

7905 North Brother Boulevard

Bartlett, TN 38133

In Canada: Brother International Corporation (Canada), Ltd.

- Marketing Dept.

1, Rue Hotel de Ville Dollard-des-Ormeaux, PQ, Canada H9B 3H6

Internet addresses

Brother Global Web Site: www.brother.com 

For Frequently Asked Questions (FAQs), Product Support and Technical Questions, Driver Updates and Utilities, and 
User’s Guides: support.brother.com 

For Brother Accessories & Supplies:

In USA: www.brothermall.com 

In Canada: www.brother.ca 

In European countries: Visit www.brother.eu for contact information for your local Brother office.

http://www.brother.com/
http://support.brother.com
http://www.brothermall.com/
http://www.brother.ca/
http://www.brother-usa.com/service/
http://www.brother.eu/
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Technical support (for PageManager and BizCard)

For USA

For Canada

Other countries

NOTE
For all other issues, see For customer service on page 83.

Company name: NewSoft America Inc.

Postal Address: 47102 Mission Falls Court, Suite 202 Fremont CA 94539

Telephone: 510-770-8900

Fax: 510-770-8980

E-mail Address: contactus@newsoftinc.com

URL: www.newsoftinc.com 

E-mail Address: contactus@newsoftinc.com

E-mail Address: tech@newsoft.eu.com

http://www.newsoftinc.com
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